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Veiligheidsmaatregelen

& wrarscHUWING

Lees deze gebruiksaanwijzing zorgvuldig door om
ervoor te zorgen dat u het product correct gebruikt
en gevaarlijke situaties en letsel te voorkomen.

Het niet in acht nemen van de instructies voor dit product kan
leiden tot ernstige verwondingen.

Productgebruik

Onjuist gebruik kan resulteren in een

explosie, brand of een elektrische scho

Demonteer, repareer of
wijzig het product niet zelf.

Zorg dat het product niet nat
wordt. Het product is niet
waterbestendig.

Als het product nat is geweest,
mag u het niet meer gebruiken.
Neem contact op met een Service
Center.

Leg het product niet in een in
vochtige, stoffige of vuile
omgeving. Hierdoor kan er
brand ontstaan en loopt u het
risico op een elektrische schok.

Bewaar of gebruik het product
niet in een omgeving waar de
temperatuur hoger is dan 35°C
(bijvoorbeeld een sauna of in
een geparkeerde auto).

Tijdens de zomer kan de temperatuur in
een geparkeerde auto oplopen tot 80°C.

Raak de oplader niet met
natte handen aan.

Vermijd gehoorbeschadiging

Als u de oordopjes of hoofdtelefoon
gedurende langere tijd gebruikt, kan dit
ernstige schade aan het gehoor veroorzaken.
Als u gedurende langere tijd wordt blootgesteld aan geluid
hoger dan 85 db, zal dit negatieve gevolgen voor uw
gehoor hebben. Hoe harder het geluid, hoe groter de
beschadiging aan uw gehoor (een normaal gesprek vindt
plaats op 50 tot 60 db, het geluidsniveau op straat is
ongeveer 80 db). U wordt ten zeerste aangeraden het
volumeniveau op middel in te stellen (het middelniveau is
normaal gesproken minder dan 2/3 van het maximum).

Als u een suizend geluid in uw oren hoort, stel
het volume dan naar beneden bij of gebruik de
oordopjes of hoofdtelefoon niet meer.

Vermijd het risico op een verkeersongeluk

Gebruik de oordopjes niet als u op een
fiets zit of een auto of motor bestuurt.

Dit kan een ernstig ongeluk veroorzaken.

Het is bovendien in enkele landen bij wet verboden.
Het gebruik van oordopjes op de weg, en vooral bij
oversteekplaatsen, kan tot ernstige ongelukken leiden.

Zorg voor uw eigen veiligheid ervoor dat
het kabeltje van de oordopjes niet achter
uw arm of objecten in de omgeving blijft
hangen als u jogt of wandelt.
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het product veroorzaken.

Het niet opvolgen van alle instructies kan tot lichamelijk letsel leiden of schade aan

Productgebruik
Belangrijke gegevens beheren Bescl nge het product voorkomen

Beschadigingen aan het product voorkomen
)
(]

Zorg dat u een reservekopie
van belangrijke gegevens
maakt.

Houd er rekening mee dat
Samsung niet aansprakelijk is
wanneer er gegevens verloren
gaan door een defect, reparatie
of andere oorzaak.

=
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Zorg dat u het product
nergens tegen stoot en laat
het product niet vallen.

Plaats geen zware voorwerpen
op het product.

nt
Voorkom dat externe deeltjes ¢
of stof in het product komen.

&

S

Gebruik uitsluitend door
Samsung geleverde of
goedgekeurde accessoires.

Spuit geen water op het
product. Maak het product niet
schoon met chemische midde-
len als benzeen of thinner.
Hierdoor kan er brand ontstaan,
kunt u een elektrische schok
krijgen en kan het oppervlak
beschadigd raken.

Plaats het product niet naast
magnetische objecten.
Hierdoor kan het product niet
goed functioneren.
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Basisinformatie

Onderdelen

| De onderdelen controleren

Speler Oortelefoon

USB-kabel Installatie-cd Halsriem / Draagtas

= Het ontwerp van de accessoires kan ter verbetering van het product zonder voorafgaande kennisgeving
worden gewijzigd.



| Voorkant, rechterzijde
Het is voldoende om de toetsen aan te raken.

Display ¢

Toets Menu 4

Toets Vorige < 5 s | Toets Aan/uit en

AT E g > Vergrendelen
P N e
- 106lS o Y §
Toets Afspelen/ v | % °
<« .|
Onderbreken/Selecteren SN




Basisinformatie

Onderdelen (vervolg)

| Onderzijde/Achterzijde

USB-
=17 " aansluiting

I— » Aansluiting

koptelefoon

[Onderzijde] .
[Achterzijde] Resetopening

Aansluiting oortelefo0on R

» Onderzijde

Oortelefoon



Basisinformatie

De informatie op het scherm

| Muziek

~oR, Normal

1.Lifeis cool

002/020

1 Afspeelmodus

2 Grafische equalizer

3 Muziekinformatie

4 Voortgangsbalk bij afspelen

5 Huidig muzieknummer /
Alle nummers

> 00:02:20

6 Geluidseffecten

7 Batterijstatus

8 Indicator Afspeeltijd

9 Indicator Afspelen / Onderbreken

= De schermafbeeldingen dienen slechts ter illustratie. Het scherm kan er in werkelijkheid anders

wiEge UEen:




Basisinformatie

Functies van de toetsen

functies en gebruik

O[[Hotpr] |

D

10

Schuiven en vasthouden in de tegenovergestelde richting van de pijl om het
apparaat in of uit te schakelen.
Schuiven in de richting van de pijl om de knoppen te vergrendelen.

Ingedrukt houden om het hoofdmenu weer te geven.
Kort indrukken om naar het vorige scherm te gaan.

Omhoog, omlaag, links en rechts, en functieselectie.
«~ =+ Indrukken om één selectie omhoog of omlaag te gaan.

Indrukken om één selectie naar links of naar rechts te gaan.
Ingedrukt houden om omhoog of omlaag te blijven gaan.

O Kort indrukken om afspelen/onderbreken en functie te selecteren,
naar het volgende scherm gaan.

Zoeken naar een nummer en volume instellen tijdens luisteren naar
muziek.

Ingedrukt houden om naar een punt in het huidige nummer te
spoelen.

Indrukken om naar het vorige nummer te gaan of het huidige
nummer vanaf het begin af te spelen.

Ingedrukt houden om naar een punt in de huidige track te spoelen.
Hierop tikken om naar de volgende track te gaan.

" Indrukken om het volume te verlagen/verhogen.

= Indrukken om het optiemenu weer te geven.



0 Licht aantikken met de
vingertop.

n = Bedien het aanraakvlak niet met scherpe voorwerpen, maar alleen met de vingertoppen.
LETop Anders kan het aanraakvlak worden beschadigd.

= Druk niet op het aanraakvlak met vuile vingers.

= Tik niet op het aanraakscherm met uw handschoenen aan. Anders zal de knop op geen enkele manier

functioneren.

11



12

Basisinformatie

Veiligheid van de batterijlader

KANS OP ELEKTRISCHE SCHOK. NIET OPENMAKEN

De ongeisoleerde onderdelen bhinnenin de oplader
kunnen een elektrische schok veroorzaken.

Maak de behuizing van de oplader niet open om
uw eigen veiligheid niet in gevaar te brengen.

Lees deze gebruikershandleiding door om mogelijke
problemen te voorkomen bij het gebruik van de oplader.

f = Om brand of een elektrische schok te voorkomen, mag u de lader niet in de buurt van water
WAARSCHUWING ~ gebruiken.

n = Gebruik de oplader alleen bij een stopcontact dat overeenkomt met de vorm van de stekker op de
LETOP omvormer om elektrische schokken te voorkomen.

= Zorg ervoor dat de stekker van de oplader volledig in het stopcontact zit.




Basisinformatie
H Laad de batterij volledig op voordat u de speler voor het eerst in
De b atter IJ O p I ad en gebruik neemt of wanneer de speler enige tijd niet is gebruikt.

Bij uw speler is een lader meegeleverd.

Sluit de lader aan op een stopcontact.
= Oplaaditijd : ongeveer 4 uur

n = Vermijd het risico van brand door de batterij niet langer dan 12 uur op te laden.
= Sluit niet meerdere apparaten aan op hetzelfde stopcontact.
LETOP & Gebruik geen defecte lader.
= Als u de oplaadbare batterij voor het eerst gebruikt of nadat u de batterij verschillende maanden
niet hebt gebruikt, moet u deze eerst volledig opladen.
= Als u de batterij te lang oplaadt, gaat dit ten koste van de levensduur van de batterij.
= De oplaadbare batterij is een verbruiksartikel en de capaciteit ervan neemt geleidelijk aan af.
= U kunt de levensduur van uw batterij verlengen door de volledig opgeladen batterij te gebruiken
totdat deze volledig leeg is en de batterij vervolgens helemaal op te laden voordat u deze opnieuw
gaat gebruiken.
= Wees ervan bewust dat wij elke verantwoordelijkheid afwijzen voor schade, die het gevolg is van
verloren gegevensbestanden (bewaard of opgenomen) vanwege defecten, reparatie of andere
oorzaken. Anders kan dit leiden tot brand of elektrische schokken.
= Raak de lader niet met natte handen aan.

= Het volledig opladen via de USB-kabel duurt ongeveer vier uur, hoewel dit per computer kan verschillen.

= Aangezien een batterij een verbruiksartikel is, neemt de levensduur van de batterij na verloop van tijd
geleidelijk af. 13
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Basisinformatie

Basisfuncties

| De speler in- en uitschakelen

o1 Normal ‘| De speler inschakelen

Houd de [ HOLD »]-schakelaar ingedrukt in de tegenovergestelde
richting van de pijl.
= De speler wordt ingeschakeld.

De speler uitschakelen

Houd de [ HOLD »]-schakelaar nogmaals ingedrukt in de
tegenovergestelde richting van de pijl.

= De speler wordt uitgeschakeld.

1Lifeis cool

0021020

Q = De speler wordt automatisch uitgeschakeld als geen van de toetsen gedurende een vooraf
OPHERKNG ingestelde tijd wordt ingedrukt (standaard: 1 minuut) in de pauzestand. » Pagina 46

| Muziek afspelen

w00, Normal (i Houd [ 0 ] ingedrukt om het hoofdmenu weer te geven.

Druk op de toets [ % *] om <Music> (Muziek) te selecteren en
druk vervolgens op de toets [(D].

= Het menu Muziek wordt weergegeven.

Druk op de toets [ « “]en [ ()] om het gewenste muziekbe-
stand te selecteren.

Druk op de toets [ O)].

= Het muziekbestand wordt afgespeeld.

1Lifeis cool

0021020

= Druk op de toets [ 0 ] om naar het vorige scherm te gaan.
OPMERKING = Houd [ © ]ingedrukt om het hoofdmenu weer te geven.




| volume instellen

son, Normal "l Druk op de toets [ « = ].
= Er wordt een volumesymbool weergegeven.

« Druk op de toets .~ om het volume te verhogen en op -+ om het volume te
verlagen.

1Lifeis cool

0021020

208 Normal "1 Wanneer de vergrendelfunctie is ingeschakeld, zijn alle toetsen
vergrendeld. Dit is handig tijdens het wandelen of joggen.

1 Schuif de [ HOLD »]-schakelaar in de richting van de pijl.

2 Duw de [ HOLD »]-schakelaar in de tegengestelde richting
van de pijl om de toetsen te ontgrendelen.

15
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Basisinformatie

Basisfuncties (vervolg)

| De speler resetten

Als de speler niet meer goed
functioneert, kunt u de speler opnieuw
} initialiseren door op de Resetopening
eselopening  te drukken.

Druk met een puntig voorwerp, zoals een
veiligheidsspeld, aan de onderzijde van
RESET het product de Resetopening in.
[ = Het systeem wordt geinitialiseerd.
» Met de Reset-functie worden geen

tijdgegevens en gegevens in het ingebouwde
[ geheugen verwijderd.




Het gewenste bestand laden

Samsung Media Studio iNStalleren S e mao o ae

computer naar de speler.

= Installeer het programma op een computer met Windows XP nadat u zich hebt aangemeld als
LETop  beheerder. Raadpleeg de gebruiksaanwijzing voor meer informatie over hoe u zich aanmeldt

als beheerder.

Voordat u begint! Plaats de installatie-cd die bij de speler is geleverd in het cd-romstation.

V

+ User Manual
% Exit

% Install now QA%

+ Install now

The setup program stars capying program fes using the.
following information.

Cick [CUSTOM] to instal ater setup instalation setings o click
INEXT] o stat copying fles wih the curent setings.

Curtent Settings:

Instalation Type =
uick Instal: Select to instal the Samsung Media Stud

Instalton Infomation
Folder to Install D:\Program Files\SamsungSamsung
rogram Folder ‘Samsung Media Studo 5

Gracenate Tems of Use

This applcation cortajas sallwala o Giaceaale Lo o

[You agres that you

(You agres that your
e Gracenote Serv

cusTom ]

1 Klik op <Install now> (Nu installeren).

2 Klik op <NEXT> (Volgende).
= Media Studio wordt geinstalleerd.

= Nadat de installatie is voltooid, wordt er een
pictogram op het bureaublad geplaatst en wordt
Media Studio gestart.

17
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Het gewenste bestand laden

Aansluiten op de computer

Gebruik voor het aansluiten van de speler op een computer de meegeleverde USB-kabel.

1 Sluit de USB-kabel aan op de USB-poort (‘I} ) van de computer.

2 Sluit het andere uiteinde van de USB-kabel aan op de USB-aansluiting aan de
onderkant van de speler.



| Systeemvereisten

De PC moet aan de volgende minimumvereisten voldoen:

= Pentium 300MHz of hoger = Windows XP Service Pack 2 of hoger
= DirectX 9.0 of hoger = USB 2.0-poort
= 100 MB vrije schijfruimte = Cd-romstation (2x of hoger)

= Windows Media Player 10.0 of hoger = Resolutie 1024 X 768 of hoger

= Als u de speler aansluit via een USB-hub, kan de verbinding instabiel zijn. Sluit de speler daarom

LETOP rechtstreeks aan op de computer.

= Als u de speler op uw computer aansluit terwijl de batterijen bijna leeg zijn, zal de speler de status
van de batterijen automatisch controleren en zal hij zichzelf gedurende enkele minuten opladen
alvorens verbinding te maken met de computer.

19



Het gewenste bestand laden

Bestanden/mappen toevoegen in Samsung
Media Studio

Met Media Studio kunt u bestanden en mappen selecteren en ordenen voor
overdracht naar uw speler.

o (@) @) @@
Ay B oot
= . g
. ___[Deew -
b Toom | Theme | Ratr Py Court | L = =
o o i _ a A partable | TP
| Troe
MOC Wk X 87 A Ferahcuse - The Best - 10. 'When | Look I

prseseadig
8

LR LT M‘

3 | [ Add Folder d}_‘ Add File
o : ,:l R

(@3} selectnd Fles: 1, Torai Fies: 10 Cﬂmd md ;wrl

Raadpleeg de Help voor meer informatie over hoe u Media Studio kunt gebruiken.
= Klik op <MENU> [ <Help> [ <Help> in het menu boven in Media Studio.



= Sluit de speler aan op de computer.

= Media Studio moet zijn geinstalleerd op de computer.

Media Studio wordt automatisch gestart wanneer de speler is aangesloten op de

computer.

= Als het programma niet automatisch wordt gestart, dubbelklikt u op het pictogram 2 voor Media

Studio op het bureaublad.

Klik op het gewenste bestandspictogram aan de linkerzijde.

. Kies het bestandstype dat u wilt overbrengen door op een van deze pictogrammen te klikken.
| & verwijst naar een muziekbestand en | @ verwijst naar een foto.

ETe

= Klik op het pictogram

om de lijst etc. weer te geven. In de ETC-lijst zijn de andere

bestandstypen opgenomen (bijv: TXT, XOV, etc) buiten muziek-, foto- en filmbestanden.

| Mappen toevoegen

3
4

Klik op <Add Folder> (Map toevoegen) onder in
Media Studio.

= Het venster Map openen wordt weergegeven.

Selecteer de map die u wilt toevoegen en klik op
<OK>.

= De bestanden van de geselecteerde map worden aan de lijst
aan de linkerzijde van het Media Studio-scherm toegevoegd.

| Bestanden toevoegen

Open Folder (@]

[Aincluding the subfolder

Dr{pacuments and Settings siiDeskiop

(L My Documents
&3 My Computer
& 33 Floppy (A2
o Local Disk (C1)
5 < eng (0
(51122 Documents and Settings
53 Al Users

3 Klik op <Add File> (Bestand toevoegen) onder in
Media Studio.
» Het venster Openen wordt weergegeven.
4 Selecteer de bestanden die u wilt toevoegen en klik
op <Open> (Openen).
= De geselecteerde bestanden worden aan de lijst aan de
linkerzijde van het Media Studio-scherm toegevoegd.




Het gewenste bestand laden

Bestanden overbrengen naar de speler met
Samsung Media Studio

Voer de volgende stappen uit om bestanden van uw PC over te brengen naar de speler.

SAMSUNG Medusiudie (wnes

oiom @)@ G

nm My Alum E Porstie
T [l @ @ erc] e, oo s Dseach~
S| Type ML st A e Tme Theme  hating Play Court | Los. — . =
) “vaghwsy Bhes” Morc Seale . Spea Ot sz 133 o  Partable | YPK3
B I} _ |
L) T3 Yo Cal B Love 11 Garchoe b7, MDC s AE ... CEver £ %] Frohousa - The Best - 10. ‘han 1Look L.
® 20 wame kil covanen | Fgrentos P e Tabon 1. b e
BT e b Yo ot bt QN e FU]
B o P Mrv2Bon loHasDrems  Ral = -
B 20 o Tk Wetein. [} Faretb, = e 5
© 0 Sepmtmyrent B g T Smmers. ok - &
B E oo B O it
- When o Debee. Herish Car .. AlAE@OAD, L=
baar venster |
i o
] ) ) 2048/ 15 D NewFobder.
=L I ] o] |
(%) Selected Fies: 1, Tokal Fles, 10 (3 add Folder 4k Add File

% = De technologie voor het herkennen van muziek en verwante gegevens wordt geleverd door
oyERdi;  Gracenote en Gracenote CDDB® Music Recognition Service™.
=« CDDB is een gedeponeerd handelsmerk van Gracenote. Het logotype en logo van Gracenote,
Gracenote CDDB en het logo “Powered by Gracenote CDDB” zijn gedeponeerde han-
delsmerken van Gracenote. Music Recognition Service en MRS zijn servicemerken van
Gracenote.




= Sluit de speler aan op de computer.
» Media Studio moet zijn geinstalleerd op de computer.

1 Media Studio wordt automatisch gestart wanneer de speler is aangesloten op de computer.
= Als het programma niet automatisch wordt gestart, dubbelklikt u op het pictogram ) voor Media
Studio op het bureaublad.

2 Klik op het gewenste bestandspictogram aan de linkerzijde.

. Kies het bestandstype dat u wilt overbrengen door op een van deze pictogrammen te klikken.
[ verwijst naar een muziekbestand en | @ verwijst naar een foto.

= Klik op het pictogram =<l om de lijst etc. weer te geven. In de ETC-lijst zijn de andere
bestandstypen opgenomen (bijv: TXT, XQOV, etc) buiten muziek-, foto- en filmbestanden.

3 Selecteer het over te brengen bestand in de linker bestandenlijst.

4 Klik op het symbool & .

» De geselecteerde bestanden worden overgebracht naar de speler.

= Koppel de USB-aansluiting niet los tijdens de bestandsoverdracht. Hierdoor kan de speler of
LETop  de computer beschadigd raken.

-

= Wanneer u een fotobestand naar de speler verbrengt met <Media Studio>, wordt het bestand vé6r
de overdracht geconverteerd naar JPG-formaat. Tevens wordt de bestandsgrootte aangepast.

OPMERKING
= Een fotobestand dat u naar de speler overbrengt zonder <Media Studio> kan er anders uitzien

dan de bron op het scherm van de speler.

23



Naar muziek luisteren

Naar muziek luisteren

Voordat u begint De oortelefoon aansluiten, de speler aanzetten en de batterij controleren.

Bijvoorbeeld, afspelen op artiest

)\
1 Houd [ ] ingedrukt om het hoofdmenu weer
te geven.

2 Druk op de toets [« *] om <Music> (Muziek) te
selecteren en druk vervolgens op de toets [)].

MUSIC ssss « Het menu Muziek wordt weergegeven.

Menu Muziek

<Now Playing> (Nu speelt): hier kunt u het huidige nummer
zien.

<Artists> (Artiest): afspelen op artiest

<Albums> (Album): afspelen op album

<Tracks> (Muzieknummer): afspelen in numerieke of
alfabetische volgorde

<Genres> (Genre): afspelen op genre

<Playlists> (Afspeellijst): afspelen op afspeellijst

3 Druk op de toets [ «~ =] om <Artist> (Artiest) te
selecteren en druk vervolgens op de toets [)].

= De volgende muziekbestanden zijn compatibel met de speler: MP3, WMA, Secure WMA.
= MP1- of MP2-bestanden waarvan alleen de extensie is gewijzigd in MP3, kunnen niet worden

PUERKIG fgespeeld op de speler.




Music

® Now Playing

-
2

4 Druk op de toets [ -~ =] om een artiest te
selecteren en druk vervolgens op de toets [ O)].
= van de artiest worden weergegeven.

5 Druk op de toets [ «~ =+ ] om een album te
selecteren en druk vervolgens op de toets [ O)].

»« De muziekbestanden van het geselecteerde album wor-
den weergegeven.

6 Druk op de toets [ -~ =] om een af te spelen
muziekbestand te selecteren en druk
vervolgens op de toets [(D)].
= De muziek wordt afgespeeld.

25
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Naar muziek luisteren

Naar muziek luisteren (vervolg)

| Het afspelen onderbreken

1 Druk op de toets [ ()] terwijl de muziek wordt afgespeeld.
= Het afspelen van de muziek wordt onderbroken.

2 Druk nogmaals op [()].
» De muziek wordt afgespeeld vanaf het punt waar het afspelen is gestopt.

= Het toestel wordt automatisch uitgeschakeld wanneer gedurende een bepaalde tijd geen toetsen worden
OPVERKNG  ingedrukt (standaard: 1 minuut) in de stopstand. » pagina 46

| In een nummer zoeken

1 Houd [ < ] ingedrukt terwijl het geselecteerde nummer wordt afgespeeld.
= Er wordt gezocht richting het begin of het einde van het nummer.

2 Laat de toets los op het punt waar u wilt starten.
= Het nummer wordt afgespeeld vanaf het moment dat u de toets loslaat.



|Afspe|en vanaf het begin van het huidige nummer

Druk na 3 seconden afspelen op [ < ].

= Het huidige nummer wordt afgespeeld vanaf het begin.

| Het volgende/vorige nummer afspelen

Druk binnen 3 seconden afspelenop [ < ].
» Het vorige nummer wordt afgespeeld.
Druk op de toets [ = ].

= Het volgende nummer wordt afgespeeld.

= Wanneer u VBR-bestanden afspeelt, wordt het vorige nummer mogelijk niet afgespeeld, ook al drukt
LETOP u binnen 3 seconden op [ % 1.

27
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Naar muziek luisteren

Afspeellijst maken met Samsung Media Studio

Een afspeellijst is een lijst met uw favoriete nummers.
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Klik op <My Album> (Mijn album) boven in Media Studio.
= Het venster <My Album> (Mijn album) wordt weergegeven.

2 Klik onder in het venster op <New Album> (Nieuw album).
= Het venster voor het maken van een nieuw album wordt weergegeven.

3 Geef de albumtitel op en Kiik op <OK>.

= Er wordt een nieuw album (afspeellijst) gemaakt en opgeslagen in het gedeelte My Album (Mijn
album) van Media Studio.



| Muziekbestanden naar een afspeellijst overbrengen

Klik op <My PC> (Mijn PC) boven in Media Studio.
= Het venster <My PC> (Mijn PC) wordt weergegeven.

Klik op <My Album> (Mijn album) in de
rechterhoek van het venster.

» Het albumvenster wordt weergegeven.

Dubbelklik op het gewenste album in het
rechtervenster.

4 Selecteer in het venster <My PC> (Mijn PC) de
bestanden die u wilt overbrengen.

5 Klik op het symbool & .

= De geselecteerde bestanden worden aan het album
(afspeellijst) toegevoegd.

|Afspee|lijst exporteren met Media Studio

Klik op <My Album> (Mijn album) boven
in Media Studio.

= Het venster <My Album> (Mijn album) wordt
weergegeven.

Klik op <Portable> (Export) in de rechterhoek
van het venster.
= Het venster <Portable> (Export) wordt weergegeven.
Selecteer het gewenste album in de lijst
<My Album> (Mijn Album).

4 Klik op het symbool & .

= Het geselecteerde album wordt naar de speler
overgebracht en opgeslagen in <Music> (Muziek) O
<Playlists> (Afspeellijst).
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Naar muziek luisteren

Een afspeellijst afspelen

B Raadpleeg pagina 28~29 voor meer informatie over het maken en overbrengen
\Voordat u begint naar de speler van afspeellijsten.

1 Houd de toets [ 0 ] ingedrukt om het hoofdmenu weer te
geven.

2 Druk op de toets [ % *] om <Music> (Muziek) te selecteren en
druk vervolgens op de toets [ O)].

® Playlists « Het menu Muziek wordt weergegeven.

3 Druk op de toets [ «~ =] om <Playlists> (Afspeellijst) te
selecteren en druk vervolgens op de toets [()].
» De afspeellijsten worden weergegeven.

= Als geen afspeellijst wordt gevonden, wordt de melding <No File> (Geen
bestand) op het scherm weergegeven.

4 Druk op de toets [ -~ =] om de gewenste afspeellijst te
selecteren en druk vervolgens op de toets [(D)].
« De muziekbestanden van de geselecteerde afspeellijst worden
weergegeven.
5 Druk op de toets [ «~ = Jom een af te spelen muziekbestand te
selecteren en druk vervolgens op de toets [()].
= Het muziekbestand wordt afgespeeld.
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Naar muziek luisteren

Het menu Muziekopties gebruiken

| Geluidseffect selecteren

U kunt verschillende geluidseffecten selecteren om de muziek waarnaar u luistert te
verfraaien.

1 Druk op de toets [ @] terwijl u naar de muziek aan het
luisteren bent.
= Het menu met muziekopties wordt weergegeven.

2 Druk op de toets [ «~ =] om <Sound Effect> (Geluidseffect) te

selecteren en druk vervolgens op de toets [(O].

® Sound Effect = Het menu met geluidseffecten wordt weergegeven.
3 Druk op de toets [ -~ =] om het gewenste geluidseffect te
selecteren en druk vervolgens op de toets [(0)].

» U hebt de keuze uit <Normal> (Normaal), <Studio> (Studio), <Rock>
(Rock), <Classical> (Klassiek), <Jazz> (JAZZ), <Ballad> (Ballad),
<Club> (Club), <R&B> (R and B '), <Dance> (Dance), <Concert Hall>
(Concertzaal) of <User> (Gebruiker).

3D en basinstellingen

U kunt 3D-geluidseffecten en extra bas instellen.

1 Druk op de toets [ «~ = ] om <User> (Gebruiker) te
selecteren en druk vervolgens op de toets [()].

« Het gebruikersmenu wordt weergegeven.

2 Druk op de toets [ «~ =] om <3D & BASS> (3D & Bas) te
selecteren en druk vervolgens op de toets [ ()]
= Het menu 3D en basinstellingen wordt weegegeven.

3 Druk op de toets [ %= *] om naar <3D> (3D) of <Bass> (Bas) te
gaan. Druk op de toets [ «~ =] om de gewenste instelling te
selecteren en druk vervolgens op de toets [(O)].
= Voor <3D> (3D) en <Bass> (Bas) kunt u kiezen uit niveau één tot vier.
» Het bevestigingsvenster wordt weergegeven.

4 Druk op de toets [ %= *] om <Yes> (Ja) of <No> (Nee) te

selecteren en druk vervolgens op de toets [()]. 31
« De instellingen zijn voltooid.
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Naar muziek luisteren

Het menu Muziekopties gebruiken (vervolg)

EQ-instelling

U kunt individuele frequenties aanpassen om het geluid volgens uw voorkeur in te stellen.

1 Druk op de toets [ «~ =] om <User> (Gebruiker) te selecteren

en druk vervolgens op de toets [ (D)].
« Het gebruikersmenu wordt weergegeven.

2 Druk op de toets [ «~ =] om <EQ> te selecteren en druk
vervolgens op de toets [()].
» Het menu EQ-instelling wordt weergegeven.

3 Druk op de toets [ % ] om de frequentie die u wilt aanpassen
te selecteren.
Druk op de toets [ «~ =] om het niveau van de geselecteerde

frequentie aan te passen en druk vervolgens op de toets [ )].
» U kunt kiezen uit -10 tot +10 voor <EQ> (EQ).
« Het bevestigingsvenster wordt weergegeven.

4 Druk op de toets [ < *] om <Yes> (Ja) of <No> (Nee) te

selecteren en druk vervolgens op de toets [)].
« De instellingen zijn voltooid.



| De grafische equalizer selecteren

luisteren bent.
= Het menu met muziekopties wordt weergegeven.

2 Druk op de toets [ «~ =] om <Graphic EQ> (Grafische EQ) te
selecteren en druk vervolgens op de toets [(O].

0 (] m 1 Druk op de toets [ @ ] terwijl u naar de muziek aan het
2

® Graphic EQ ) .
= Het menu voor de grafische equalizer wordt weergegeven.

3 Druk op de toets [ «~ =] om <On> (Aan) of <Off) (Uit) te
selecteren en druk vervolgens op de toets [(O)].

= <On> (Aan): De grafische equalizer wordt op het scherm weergegeven.
= <Off> (Uit): De grafische equalizer wordt niet op het scherm
weergegeven.

| De afspeelmodus selecteren

sa5. Normal m 1 Druk op de toets [ @] terwijl u naar de muziek aan het luisteren
bent.
= Het menu met muziekopties wordt weergegeven.

2 Druk op de toets [ «~ = ] om <Play Mode> (Afspeelmodus) te
selecteren en druk vervolgens op de toets [ O)].
= Het menu voor de afspeelmodus wordt weergegeven.

3 Druk op de toets [ -~ = Jom de gewenste modus te selecteren

en druk vervolgens op de toets [ ].
= U hebt de keuze uit <Normal> (Normaal) <Repeat One> (Eén herhalen)
<Repeat> (Herhalen) of <Shuffle> (Shuffle).

<Normal> (Normaal) : alle nummers worden in volgorde eenmaal
afgespeeld.

<Repeat One> (Eén herhalen): één bestand herhalen.

<Repeat> (Herhalen): alle bestanden herhalen.

<Shuffle> (Shuffle): de bestanden worden in willekeurige volgorde
afgespeeld. 33

® Play Mode
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Afbeeldingen bekijken

Afbeeldingen bekijken

okl sl Zie pagina 22-23 voor het overbrengen van fotobestanden naar uw speler.

-

~

++ PhOtO &4

1

1 Houd de toets [ * ] ingedrukt om het hoofdmenu
weer te geven.

2 Druk op de toets [ % *] om <foto> te selecteren
en druk vervolgens op de toets [()].
» De lijst met foto's wordt weergegeven.

3 Druk op de toets [ «~ = < ] om het gewenste
fotobestand te selecteren en druk vervolgens
op de toets [O)].

« Het geselecteerde bestand wordt weergegeven.
« Het weergeven van grote foto's kan iets langer duren.

o :--- m |Z| | Diashow bekijken

GFE

f_-_

|

OPNERKING

= U ziet steeds van het
bestand een miniatuurfoto
met beknopte gegevens
in de fotolijst.
Voor een bestand dat
geen gegevens bevat, ziet
u in plaats daarvan

U kunt uw fotobestanden geordend als een
diashow bekijken.

m Druk op de toets [()] in de stand Foto's
weergeven.
» De diashow begint.
Druk op de toets [()] om de diashow te
beéindigen.

| De vorige / volgende foto te bekijken.

Druk op de toets [ = *].
= De vorige of volgende foto wordt op het scherm weergegeven.



Afbeeldingen bekijken

Het menu Foto-opties gebruiken

NL

| Naar muziek luisteren terwijl u een foto bekijkt.
U kunt naar de muziek luisteren die u het laatst hebt afgespeeld terwijl u een foto bekijkt.

t 1 Druk op de toets [ @ ] terwijl u een foto aan het bekijken bent.

= Het menu met foto-opties wordt weergegeven.

2 Druk op de toets [ ()] <Background Music On> (Achtergrondmuziek
aan) of <Background Music Off> (Achtergrondmuziek uit) te selecteren.

= <Background Music On> (Achtergrondmuziek aan): U kunt naar de muziek
luisteren die u het laatst hebt afgespeeld terwijl u een foto bekijkt.

» <Background Music Off> (Achtergrondmuziek uit): Er wordt geen
achtergrondmuziek gespeeld terwijl u een foto bekijkt.

Add to Screen S..
Zoom

| Een foto toevoegen aan de lijst met screensavers.

t 1 Selecteer het fotobestand dat u aan de lijst met screensavers wilt
toevoegen.

Druk op de toets [ @ ] terwijl u een foto aan het bekijken bent.

ERree = Het menu met foto-opties wordt weergegeven.

Druk op de toets [ «~ ] om <Add to screensaver> (Aan
246 screensaver toevoegen) te selecteren en druk vervolgens op de
toets [(D].

= Het geselecteerde fotobestand wordt aan de lijst met screensavers toegevoegd.

% = Selecteer <Photo> (Foto) in <Settings> (Instellingen) - <Display> (Weergave) — <Screen Saver>
(Screensaver) en de geselecteerde foto wordt als screensaver weergegeven op het scherm. » pagina 45

= Als u <Default Set> (Standaard Instellen) instelt, zal de screensaver worden geinitialiseerd op
<Analog Clock> (Analoge Klok).

OPMERKING
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Afbeeldingen bekijken

Het menu Foto-opties gebruiken (vervolg)

| Een foto vergroten

Background Mu..
Add to Screen S..

1
2

Druk op de toets [ @ ] terwijl u een foto aan het bekijken bent.

= Het menu met foto-opties wordt weergegeven.

Druk op de toets [ «~ =] <Zoom> te selecteren en druk ver-
volgens op de toets [()].

= Het menu voor zoominstellingen wordt weergegeven.

Druk op de toets [ «~ = ] de gewenste vergrotingsfactor te
selecteren en druk vervolgens op de toets [ )].
= U kunt kiezen uit <100%>, <200%> of <400%>.

Druk op de toets [ «~ * % ¥] naar het gedeelte van de foto
te gaan dat u wilt vergroten.

U annuleert het vergroten door in de zoomopties 100% te
kiezen en vervolgens op de toets [(].

= Hiermee keert u terug naar de normale afmeting.



Naar de FM-radio luisteren

Naar de FM-radio luisteren

Voordat u begint De koptelefoon aansluiten, de speler aanzetten en de batterij controleren.

(M 1 Houd de toets [ ® ] ingedrukt om het
hoofdmenu weer te geven.

2 Druk op de toets [ % *] om <FM Radio>
(FM-radio) te selecteren en druk vervolgens op
de toets [D].

+«FMRadio, .. » FM-radio wordt ontvangen.

1 | De dempfunctie gebruiken

Druk op de toets [ ()] tijdens het luisteren naar
de FM-radio.

= Het geluid wordt onderdrukt.
» Druk nogmaals op [ ©)] om het geluid weer in te schakelen.

A ———

= Sluit altijd de oortelefoon aan op uw speler als u frequenties zoekt of instelt. De oortelefoon werkt als
LETop  @antenne voor het ontvangen van FM-radio.
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Naar de FM-radio luisteren

Naar de FM-radio luisteren (vervolg)

| Overschakelen naar de handmatige stand
Selecteer deze stand als u de FM-band handmatig per frequentie wilt afzoeken.

Preset Mode

- 1 Druk op de toets [ 8] in <Preset Mode>
(Voorinstellingsmodus).

® Go to Manual ..

2 Druk op de toets [ «~ =] om <Go to Manual Mode> (Ga naar
Handm. Modus) te selecteren en druk vervolgens op de
toets [D)].

= <Manual Mode> (Handm. Modus) wordt op het scherm weergegeven.

| Overschakelen naar de voorinstellingsmodus

Selecteer deze stand als u de opgeslagen FM-voorinstellingen wilt afzoeken.
Manual Mode {m

1 Druk op de toets [ @] in <Manual Mode> (Handm. Modus).

91 A vHz 2 Druk op de toets [ -~ = ] om <Go to Preset Mode> (Ga naar

» GO to Preset .. Preselectiestand) te selecteren en druk vervolgens op de toets [O].
= De <Preset Mode> (Voorinstelingsmodus) wordt op het scherm weergegeven.

Druk op de toets [ = *] om de vooringestelde frequentie te
selecteren.

= Nadat de voorinstellingsmodus op het scherm wordt weergegeven, kunt
u een radiozender selecteren om naar te luisteren.

Als er geen frequentie vooraf is ingesteld, wordt de melding <Preset list does not exist.> (Lijst
preselectie bestaat niet) weergegeven en schakelt de speler niet over naar de voorinstellingsmodus.
OPUERKNG w Alls u <Default Set> (Standaard Instellen) instelt, zullen de opgeslagen preselectielijsten worden gewist.
= Als u <Preset List> (Lijst Preselectie) in het FM-optiemenu selecteert, worden de vooringestelde
frequenties weergegeven.
Raadpleeg pagina 40~41 voor meer informatie over preselectie.




| Automatisch frequenties zoeken

NEREEINEES I Houd [ % *]ingedruktin <Manual Mode> (Handm. Modus).
9 1 1 = De dichtstbijzijnde frequentie wordt gezocht.
J |. | MHz

<)

| Handmatig frequenties zoeken

Repuelboes "l Druk op de toets [ ] in <Manual Mode> (Handm. Modus).
91 1 - = Wanneer u de toets indrukt wordt er naar een frequentie gezocht.
. 4

<)
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Naar de FM-radio luisteren

Een freq u entle | n Stel | @[ Y kunt maximaal 30 frequenties instellen in de

FM-radiomodus.

| Automatisch frequenties instellen

Manual Mode

o 1 Druk in de FM-radiomodus op [ &].

91 1 MHz

2 Druk op de toets [ «~ =] om <Auto Preset> (Autom. Voorinst.)
te selecteren en druk vervolgens op de toets [()].
® Auto Preset = Het venster voor automatisch voorinstellen wordt op het scherm
weergegeven.
3 Druk op [ % *] om <Yes> (Ja) te selecteren en druk
vervolgens op de toets [()].
« Er zijn automatisch tot 30 frequenties beschikbaar.

% = Als u <Auto Preset> (Automatisch voorprogrammeren) opnieuw wilt uitvoeren nadat de frequenties
OPVERKING zijn voorgeprogrammeerd, worden alle bestaande frequenties verwijderd en kunt u geheel nieuwe
instellingen opgeven.

| Annuleren tijdens het instellen

Druk tijdens het auto scannen op [ % *] om te annuleren.

= Het automatisch voorprogrammeren wordt geannuleerd en de frequenties die tot op dat
moment zijn ingesteld, worden opgeslagen.



| Handmatig frequenties instellen
2

Manual Mode an 1 Tik op [ % *]om de gewenste frequentie in <Manual

91 1 MHz

Mode> (Handm. Modus) in te stellen.
Druk op de toets [ 8 ].

® Add Preset 3 Druk op de toets [ «~ =~ ] om <Add Preset> (Preselectie
Bijvoegen) te selecteren en druk vervolgens op de toets [ ].

= De geselecteerde frequentie wordt aan de lijst met preselecties toegevoegd.
Maximaal kunnen 30 preselectienummers opeenvolgend aan de lijst worden
toegevoegd.

Als u andere frequenties wilt instellen, volgt u stappen 1-3

hierboven.

= Als een frequentie die u wilde toevoegen al in de lijst is opgenomen, wordt de melding <This preset
already exists.> (Deze preselectie bestaat reeds) weergegeven en wordt de geselecteerde frequentie niet

OPEROG oo nevoeqd.

| Frequenties zoeken in de PRESET Mode (Voorprogrammeren)

SIS EINAEE "l Druk op de toets [ < *]in <Preset Mode>
(Voorinstellingsmodus).
91.1 e

1% 1 ANS = Het voorgeprogrammeerde nummer wordt geselecteerd en u kunt luisteren
naar uw favoriete radiozender.

|||||||||||||||||
L <) »

« Als u de preselectielijst in de voorinstellingsmodus wilt bekijken, drukt u op [ ® ] om <Preset List>
iR (Liist Preselectie) te selecteren en drukt u vervolgens op de toets [O]. 41
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Naar de FM-radio luisteren

Een voorgeprogrammeerde frequentie
verwijderen

e 1 Druk op de toets [ @ ] in <Preset Mode> (Voorinstellingsmodus).
® 89.1MHz

2 Druk op de toets [ «~ =] om <Delete Preset> (Preselectie
Wissen) te selecteren en druk vervolgens op de toets [ ].
= De vooringestelde frequenties worden weergegeven.

3 Druk op de toets [ -~ =] om het vooringestelde frequentie te
selecteren die u wilt verwijderen en druk vervolgens op de toets [ () ].
= Het bevestigingsvenster wordt weergegeven.

4 Druk op de toets [ % *] om <Yes> (Ja) te selecteren en druk
vervolgens op de toets [()].
= De geselecteerde voorinstelling wordt gewist.

5 Als u andere preselectienummers wilt selecteren en
verwijderen, volgt u stappen 1-4 hierboven.



Naar de FM-radio luisteren

FM-radio instellen

| FM-ontvangst instellen

Manual Mode

91 1 MHz

-
2

1 Druk in de FM-radiomodus op [ @ ].

2 Druk op de toets [ «~ =] om <FM Sensitivity> (FM Gevoeligheid)
te selecteren en druk vervolgens op de toets [(0)].
O (R Sty « Het menu FM Gevoeligheid wordt weergegeven.

3 Druk op de toets [ «~ = ] om de gevoeligheid te selecteren en
druk vervolgens op de toets [ ].
= U kunt kiezen uit <High> (Hoog), <Middle> (Midden) en <Low> (Laag).

= Hoe hoger de FM-gevoeligheid, des te meer frequenties kunnen worden
ontvangen.
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Instellingen

B eel d | n Stel I | n g @1 U kunt de screensaver en de uitschakeltiid van het scherm instellen.

1 Houd de toets [ ©0'] ingedrukt om het hoofdmenu weer te
geven.

2 Druk op de toets [ % *] om <Settings> (Instellingen) te
selecteren en druk vervolgens op de toets [()].
= Het menu Instellingen wordt weergegeven.

++e++ Settings

Settings 3 Druk op de toets [ «~ =] om <Display> (Weergave) te selecteren
® Display en druk vervolgens op de toets [ ].
= Het menu Weergave verschijnt.

4 Stel de gewenste functies in met [ = ] en [D].

Functies van de toetsen voor installatie

= Druk op de toets [ «~ =] om door de lijst te bladeren.

= Druk op de toets [ )] om te selecteren en uw instellingen te bevestigen.
= Druk op de toets [ ] om naar het vorige scherm te gaan.

OPMERKING




= <Screen Saver> (Screensaver): U kunt een afbeelding instellen voor het screensaver-scherm.
Kies uit <Analog Clock> (Analoge klok), <Animation1> (Animatie 1), <Animation2> (Animatie 2,
<Animation3> (Animatie 3) en <Photo> (Foto) en stel de wachttijd in. <Photo> (Foto) is de foto
die u als screensaver hebt toegevoegd onder <Add to Screen Saver> (Toevoegen aan
Screensaver). » pagina 35
U kunt kiezen uit <15sec> (15sec), <30sec> (30sec), <Imin> (1min), <3min> (3min), <5min>
(5min) en <Off> (Uit). Als geen tijd is geselecteerd, wordt de screensaver-foto weergegeven.

<Display Off> (Display Uit ): Als geen wachttijd is ingesteld, wordt het scherm automatisch
uitgeschakeld. U kunt kiezen uit <15sec> (15sec), <30sec> (30sec), <1min> (1min), <3min>
(3min), <5min> (5min) en <Always On> (Altijd aan).

Als het scherm uitgeschakeld is, tikt u op een willekeurige knop op het scherm weer in te
schakelen.

Instellingen voor screensaver

1 Druk op de toets [ «~ ] om <Screen Saver> (Screensaver) te
selecteren en druk vervolgens op de toets [()].

= Het screensaver-menu wordt weergegeven.

2 Druk op de toets [ «~ =] om de gewenste screensaver-
Be® afbeelding te selecteren en druk vervolgens op de toets [ #].

3 Druk op de toets [ «~ =] om de gewenste screensaver-
afbeelding te selecteren en druk vervolgens op de toets [()].
= Het bevestigingsvenster wordt weergegeven.

4 Druk op de toets [ %= *] om <Yes> (Ja) te selecteren en druk
vervolgens op de toets [()].

= Het instellen van de screensaver is voltooid.
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Instellingen

Ts W] U kunt niet alleen de huidige tijd instellen, maar ook de slaaptimer en de
TIJ d I n Stel I e n functie Automatisch uitschakelen

_Setings O] 1 Houd de toets [ '] ingedrukt om het hoofdmenu weer te

geven.

® Time

2 Druk op de toets [ % *] om <Settings> (Instellingen) te
selecteren en druk vervolgens op de toets [ ].
« Het menu Instellingen wordt weergegeven.

3 Druk op de toets [ «~ =] om <Time> (Tijd) te selecteren en
druk vervolgens op de toets [ ].
« Het menu Tijd wordt weergegeven.

4 Stel de gewenste functies in met [ =~ « ] en [OD].

= <Sleep Timer> (Slaaptimer): het apparaat wordt na de opgegeven tijd
automatisch uitgeschakeld. Selecteer <Off> (Uit) <15 min > (15min),
<30 min> (30min), <60 min> (60min), <90 min> (90min) of <120 min>
(120min).

= <Auto Power Off> (Autom. Uitschakelen): de speler wordt automatisch
uitgeschakeld als het afspelen is onderbroken en er gedurende de
opgegeven tijd geen toetsen worden ingedrukt. Kies uit <15 sec> (15sec),
<30 sec> (30sec), <1 min> (1min), <3 min> (3min) of <5 min> (5min).

= <Time Set> (Tijd instellen): hier kunt u de huidige tijd instellen.
» pagina 47



Tijd instellen

1 Druk op de toets [ «~ =~ ] om <Time set> (Tijd instellen) te
selecteren en druk vervolgens op de toets [(D)].

2 Tikop [ < *] om naar <AM/PM, Hour, Minute> (AM/PM, Uur,
Minuut) te gaan en gebruik [ -~ =] om de tijd in te stellen.

3 Druk op de toets [ ].

= Het bevestigingsvenster wordt weergegeven.

4 Druk op de toets [ % *] om <Yes> (Ja) te selecteren en druk

vervolgens op de toets [(D)].
= De tijdinstelling wordt opgeslagen.
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Instellingen

Taal | n StEI | | n g en U kunt de taal voor het menu instellen.

| SIS @) 1 Houd de toets [ ©0'] ingedrukt om het hoofdmenu weer te
geven.
® Language
2 Druk op de toets [ % *] om <Settings> (Instellingen) te

selecteren en druk vervolgens op de toets [()].
= Het menu Instellingen wordt weergegeven.

3 Druk op de toets [ «~ = ] om <Language> (Taal) te selecteren
en druk vervolgens op de toets [ () ].

4 Gebruik [ « ] en [0 ] om de taal voor het menu in te stellen.

» Beschikbare opties:<English>, < 8=0{ >, <Francais>, <Deutsch>,
<ltaliano>, < BAE >, < BitEhX >, < FHPX >, <Espafiol>, < Pycckuii >,
<Magyar>, <Nederlands>, <Polski>, <Portugués>, en <Svenska>.

= De ondersteunde talen kunnen worden gewijzigd of toegevoegd.
OPMERKING
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Instellingen

Systeem | n Stel I | n g @ U kunt het geheugen en de pieptoonopties instellen.

|
) Z
1 Houd de toets [ ©'] ingedrukt om het hoofdmenu weer te I
Rkl geven.
Time
Language 2 Druk op de toets [ < *] om <Settings> (Instellingen) te

selecteren en druk vervolgens op de toets [()].
= Het menu Instellingen wordt weergegeven.

3 Druk op de toets [ «~ =] om <System> (Systeem) te selecteren
en druk vervolgens op de toets [()].
= Het systeemmenu wordt weergegeven.

Stel de gewenste functies in met [ =« ] en [O].

Resume (Hervatten): u kunt instellen vanaf welk punt de speler het afspelen moet hervatten

nadat u het afspelen had onderbroken. Als u <On> (Aan) selecteert wordt het afspelen hervat
vanaf het punt waarop u het laatst het afspelen hebt onderbroken. Als u <Off> (Uit) selecteert,
wordt het afspelen hervat vanaf het begin van het nummer dat het laatst werd afgespeeld.

<Beep> (Pieptoon): hiermee kunt u toetsgeluiden inschakelen. U kunt <On> (Aan) of <Off> (Uit)
selecteren.

<Volume Limit> (Volume grens): u kunt gehoorbeschadiging bij gebruik van de koptelefoon
voorkomen door een volumegrens in te stellen. Bij <On> (Aan) is het maximum volumeniveau
20, bij <Off> (Uit) is dat 30.

<FM Region> (FM-regio): U kunt uw eigen land selecteren voor de FM-radio. U kunt kiezen uit
<Korea/USA> (Korea/VS), <Japan> (Japan) en <Other Countries> (Andere landen).

Frequentiebereik naar regio

- - Korea/lUSA: FM-frequenties in 100 kHz-spelers zoeken tussen 87.5 MHz~108.0 MHz.
OPVERKING Japan: FM-frequenties in 100 kHz-spelers zoeken tussen 76.0 MHz~108.0 MHz.

- Overige: FM-frequenties in 50 kHz-spelers zoeken tussen 87.50 MHz~108.00 MHz.

De FM-regio kan worden verwijderd of gewijzigd overeenkomstig de doelregio voor de speler.

Als u de FM-regio wijzigt, worden de opgeslagen radiofrequenties verwijderd.
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Instellingen

Systeeminstellingen (vervolg)

<Default Set> (Standaard instellen): de standaardwaarden voor alle instellingen worden hersteld.

<About> (Info): U kunt de versie van de firmware, de geheugencapaciteit en het nummer van het

bestand weergeven.

. <Firmware Version> (Firmwareversie) : de firmwareversie die momenteel wordt gebruikt.

. <Memory> ( Geheugen) : de resterende geheugencapaciteit. <Used> (Gebruikt) geeft het gebruikte

geheugen aan, <Remain> (resterend) geeft het resterende geheugen aan en <Total> (Totaal) staat voor de

totale geheugencapaciteit.

. <Files> (Bestanden): <Music> (Muziek) geeft het aantal muziekbestanden weer, <Photo> (Foto) het aantal
foto's en <Total> (Totaal) het totale aantal bestanden.

Standaard instellen

Settings

1 Druk op de toets [ «~ = ] om <Default Set> (Standaard
instellen) te selecteren en druk vervolgens op de toets [ ].
« Het bevestigingsvenster wordt weergegeven.

[OIEEETNES 2 Druk op de toets [ < *] om <Yes> (Ja) te selecteren en druk
vervolgens op de toets [(D)].

» <Yes> (Ja): alle standaardinstellingen terugzetten.

= <No> (Nee): de standaardinstellingen annuleren.

Q » Als u <Default Set> (Standaard Instellen) instelt , worden alle functies hersteld in de standaardinstellin-
iR 9en (fabrieksinstellingen).
= Het ingebouwde geheugen
Er is in werkelijkheid iets minder geheugen beschikbaar dan wordt aangegeven, aangezien de
interne firmware ook een gedeelte van het geheugen gebruikt.




Pro b I em en O p I O SS en In geval van een storing, controleert u het volgende.

Als het probleem zich blijft voordoen, kunt u contact opnemen
met het dichtsthijzijnde Samsung Service Center.

Probleem Controlepunten en problemen oplossen

. = De speler kan niet worden ingeschakeld als de batterij leeg is.
Kan de speler niet Laad de batterij op en schakel de speler nogmaals in.
inschakelen. » Druk met een scherp voorwerp de resetopening in.

= Controleer of de schakelaar [HOLD ] in de richting van de pijl is geduwd.

» Controleer of u op de juiste toets hebt gedrukt, en druk
nogmaals op de toets. » pagina 11

« Druk met een scherp voorwerp de resetopening in.

De toetsen werken niet.

= Als <Display Off> (Display Uit) is geselecteerd in het menu
Het scherm wordt niet <Settings> (Instellingen) — <Display> (Weergave), wordt het
ingeschakeld. scherm uitgeschakeld. Tik op een willekeurige toets op het
scherm of controleer de Display-instellingen. »pagina 45
» Het scherm is in vol zonlicht mogelijk niet goed zichtbaar.
» Controleer de batterijstatus.
De speler wordt = De speler wordt automatisch uitgeschakeld wanneer de batterij leeg is. Laad de batterij op.
uitgeschakeld. « Als u <Auto Power Off> (Autom. Uitschakelen) selecteert uit
<Settings> (Instellingen) — <Time> (Tijd), dan zal de speler in
de stopstand worden uitgeschakeld. Schakel de speler in.

De levensduur van de =« De batterijstatus kan variéren, afhankelijk van de geluids- en

batterij verschilt met de weergave-instelling.

levensduur die is aangegeven = Wanneer de batterij langdurig wordt blootgesteld aan lage of

in de gebruiksaanwijzing hoge temperaturen, kan dit ten koste gaan van de levensduur
' van de batterij.

Het programma werkt

. Controleer of de computer aan de systeemvereisten voldoet.
niet goed.

P Klik op <Start> op het bureaublad van de computer om Windows

Kar: geen verbtlndlng Update uit te voeren. Selecteer Essenti€le updates en Service packs

M el GepiE en installeer alle updates. Start de computer opnieuw op en sluit de

maken. speler opnieuw aan. 51



Problemen oplossen (vervolg)

Probleem Controlepunten en problemen oplossen

Kan niet afspelen.

Kan geen bestanden
uploaden.

Er ontbreken bestanden
of gegevens.

Abnormale afspeeltijd
tijdens het afspelen.

Het product wordt warm.
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Controleer of het beschikbare bestand is opgeslagen in de speler.
Controleer of het muziekbestand is beschadigd.
Controleer of de batterij voldoende is opgeladen.

Controleer of de USB-kabel goed is aangesloten.
Sluit deze zonodig opnieuw aan.

Controleer of het geheugen vol is.
Druk met een scherp voorwerp de resetopening in.

Controleer of de USB-kabel is losgeraakt tijdens de
bestandsoverdracht. Dit kan overigens niet alleen leiden tot
ernstige beschadiging van de bestanden/gegevens, maar ook van
het product. Let goed op, want Samsung is niet aansprakelijk voor
gegevensverlies.

Controleer of het bestand een VBR-indeling (Variable Bit Rate)
heeft.

Er komt tijdens het opladen wat warmte vrij. Dit heeft geen invioed
op de levensduur of functies van het product.



OV e r Zl C ht Van m en u O p tl eS Hier kunt u de menustructuur bekijken.

Het selectievenster Menu

Music FM Radio Photo Settings
Display Time Language System
Screen saver Sleep Timer Resume
Display Off Auto Power Off Beep
Time Set Volume Limit
FM Region
Default Set
About
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Productspecificaties

Model YP-K3
Stroomvoorziening 3.7V (Li-Polymer oplaadbaar)
Vermogen ingebouwde batterij 500 mAh

Bestand Compatibiliteit

muziek : MPEG1/2/2.5 Layer3(8kbps~320kbps, 22kHz~48kHz)
WMA(48kbps~192kbps, 22kHz~48kHz)
BEELD: JPEG(ISO/IEC 10918-1/Annex F-Sequential DCT-weergave)

Uitgangsvermogen oortelefoon

20mW(France 5mW/CH)(16Q)

Frequentiebereik

20Hz~20KHz

Ruisfactor

88 dB hij 20kHz LPF(gebaseerd op 1KHz 0 dB)

Afspeelduur

Muziek 25 uur (gebaseerd op MP3 128 Kbps, volumeniveau 15 en de normale stand)

Temperatuurbereik voor gebruik

-5~35 °C (23~95°F)

Houder

Roestvrij, Plastic

Gewicht

1.76 oz (509)

Afmetingen (BxHXD)

1.73 X 3.78 X 0.27 inches (44 X 96 X 6.95 mm)

FM-frequentie

87.5~108.0MHz

Signaal-ruisverhouding FM 50dB
Totale harmonische vervorming FM | 1%
Gevoeligheid FM 38dBu

e De inhoud van deze gebruiksaanwijzing kan ter verbetering zonder voorafgaande
kennisgeving worden gewijzigd.



Gebruiksrecht

Op dit apparaat en de gebruiksaanwijzing rusten intellectuele eigendomsrechten en

auteursrechten van derden. Het gebruiksrecht van de gelicentieerde inhoud is beperkt tot

niet-commercieel gebruik door eindgebruikers. Commercieel gebruik hiervan is niet
toegestaan.

Het gebruiksrecht beperkt zich tot dit apparaat en strekt zich niet uit tot andere
niet-gelicentieerde onderdelen of processen die voldoen aan ISO/IEC 11172-3 of
ISO/IEC 13818-3 en die in combinatie met dit product gebruikt of verkocht zijn.

De licentie beperkt zich tot het gebruik van dit product voor het encoderen en/of

decoderen van geluidsbestanden die voldoen aan ISO/IEC 11172-3 of ISO/IEC 13818-3.

Deze licentie houdt geen overdracht van rechten in voor producteigenschappen
of -functies die niet voldoen aan ISO/IEC 11172-3 of ISO/IEC 13818-3.

Dit merkteken op het product of het bijbehorende
informatiemateriaal duidt erop dat het niet met ander
huishoudelijk afval verwijderd mag worden aan het einde

van zijn gebruiksduur. Om mogelijke schade aan het milieu

of de menselijke gezondheid door ongecontroleerde

afvalverwijdering te voorkomen, moet u dit product / \
van andere soorten afval scheiden en op een
verantwoorde manier recyclen, zodat het duurzame
hergebruik van materiaalbronnen wordt bevorderd.
Huishoudelijke gebruikers moeten contact opnemen
met de winkel waar ze dit product hebben gekocht of
met de gemeente waar ze wonen om te vernemen
waar en hoe ze dit product milieuvriendelijk kunnen

laten recyclen. _
Zakelijke gebruikers moeten contact opnemen met \ /
hun leverancier en de algemene voorwaarden van de

koopovereenkomsten nalezen. Dit product mag niet

worden gemengd met ander bedrijfsafval voor verwijdering.

-
2
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Wanneer u suggesties of vragen heeft met betrekking tot Samsung producten,
gelieve contact op te nemen met de klantenservice van Samsung

Samsung Electronics Benelux BV
0900 20 200 88 (€ 0,10/Min)
www.samsung.com/nl
Voor Belgié:

02/201 24 18
www.sansung.com/be

REVO0.0



